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Microplastics (MPs) pollution in the terrestrial environment has received increasing
attention over the last decade, with increasing studies describing the numbers
and types of MPs in different soil systems and their impacts on soil and crop
health. However, different MPs extraction and analytical methods are used, limiting
opportunities to compare results and generate reliable evidence for industry advice
and policymakers. Here, we present a protocol that describes the methodology for
sampling, separation, and chemical identification of conventional MPs from soil.
The method is low-cost, and the materials are readily available. This enhances
operational ease and may help with widespread adoption. The protocol provides
detailed information on sample collection from the top 0-30 cm of soil using plastic-
free utensils; simulation of different soil types through the use of various solid
media (such as bentonite clay, silicon dioxide, and non-contaminated soil), with the
addition of the same mass of polyethylene(PE)-MPs for subsequent quantification;
density separation of plastic particles utilizing saturated sodium chloride (NaCl)
solution and digestion of organic impurities in the supernatant using 4 M sodium
hydroxide (NaOH) solution; quantification of particles using fluorescent microscopy
after Nile Red staining; and polymer identification using micro Fourier-Transform
Infrared Spectroscopy (u-FTIR) or Laser-Direct Infrared (LDIR) spectroscopy. The
MPs recovery rate ranged from 83% - 90% for the abovementioned media. This

protocol presents an efficient method for soil MPs analysis that is optimized for
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feasibility, applicability, and cost-effectiveness. Moreover, the video accompanied

can guide the process of analyzing the soil MPs step-by-step virtually. This study

is dedicated to standardizing the methods for soil MPs analysis, enhancing the

connectivity and comparability of measurements, and establishing a foundation for

more standardized and scientific research.

Introduction

It is estimated that 4.8 to 12.7 million metric tons of plastic
enter the ocean annually from terrestrial sources' 2. These
plastic particles gradually degrade into smaller fragments in
response to ultraviolet irradiation, mechanical abrasion, and
biodegradation3'4. Microplastics (MPs) pollution, with plastic
particles of diameter less than 5 mm, in the soil is becoming an
increasing concern, particularly in terms of its potential effect
on soil and crop health. It is primarily driven by the continual
rise in plastic production and challenges surrounding the

appropriate disposal of plastic waste®6.

The accumulation of MPs in soil can be attributed to various
external factors. The potential sources of MPs in soils are
complex, including the utilization of plasticulture practices
(e.g., plastic mulch films, irrigation pipes, greenhouse

films, and associated infrastructure)7’8’9

and input of
organic amendments (such as sewage sludge application,
agricultural compost, and organic fertilizer)m. In addition, the
inappropriate disposal of plastic litter, decomposition of
digested food waste from food plastic packaging residue’?,

3

utilization of coated fertilizers' , wear and tear of rubber

4 and atmospheric deposition15 are also known

tires
contributors to MPs in soils. China, the leading producer and
user of agricultural plastics, particularly plastic muich films,
has been estimated to have an average abundance of MPs
in heavily plastic-mulched agricultural farmland of ca. 4231

items kg'1 (dry soil)16. In 2018, the quantities of MPs in

Chinese farmland soils within the 0-10 cm depth ranged from
4.9%x10%t0 1.0 x 107 tons, with a significant contribution from
agricultural mulch films17. Sludge applications to agricultural
soils in Europe and North America may input over 63,000
and 44,000 tons of MPs per year, respectively18. A study
in Germany showed that compost applications to arable
fields also led to an annual input of plastic particles (>1
mm) into arable fields. The application of compost led to
35 billion to 2.2 trillion plastic particlesm.The contribution of
atmospheric MPs to soils is still uncertain and requires further
quantification15. For example, the annual average input of
atmospheric MPs is estimated to be 7.9 x 104 items m™2
yr'"in China'®. The extremely wide range of sources of MPs
in soil has attracted the attention of many researchers, but
due to the diversity of sampling, extraction, and analytical
detection methods, it is difficult to integrate and compare the

results of various studies.

The accumulation of MPs from a wide range of sources
poses a potential environmental threat to global soils16,
highlighting the clear need for studies of MPs in soil. Some
studies have shown the effects of MPs on agricultural soil
include altering soil properties, impeding the growth and
development of plants and soil organisms, and impacting
soil microbial activity19'2o. Other studies have found that
MPs can accumulate in organisms at higher trophic levels

along the food chain?!, leading to a potential hazard to
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human health?2. To clarify the soil environmental effects of
MPs, it is first necessary to understand the current status
of their contamination, including their abundance, polymer
identification, and distribution characteristics. Therefore, the
accurate identification and detection of soil MPs are of

paramount importance.

Currently, a growing number of articles are exploring
the global presence of MPs in soil, with considerable
variation observed in the extraction and detection methods?3.
After the careful collection of samples (to minimize MPs
contamination), the protocol for MPs analysis typically
involves three key steps. First, density separation is widely
adopted to isolate MPs particles from the soil matrix. This
process commonly utilizes reagents such as distilled (DI)
water (1.0 g cm'3), sodium chloride (NaCl, 1.2 g cm'3),
or zinc chloride (ZnCly, 1.6 g cm'3). Secondly, methods
for removing organic impurities from the surface of MPs
include cleaning with acidic and alkaline solutions or other
oxidizing agents and enzymatic digestion24. The digestion
of organic matter in the soil matrix or adhering to MPs
particles is commonly carried out using 30% hydrogen
peroxide (H205), 65% nitric acid (HNO3), or 50% sodium
hydroxide (NaOH)25. Following the density separation and
organic matter digestion, the microscopic examination of MPs
samples is required to determine the number of particles.
This examination is supplemented with the analysis of the
chemical composition of the polymers through techniques
such as Fourier-Transform Infrared Spectroscopy (FTIR),
Raman spectroscopy, or other near-infrared spectroscopy

techniques26 .

However, each step in the MPs extraction and detection
process carries the potential for either overestimation or

underestimation of MPs occurrence. For instance, despite

the widespread use of DI water as a reagent for density
separation due to its cost-effectiveness and lack of hazardous
properties, it may lead to the exclusion of MPs particles
with higher density?” . Conversely, the widespread application
of high-density reagents may be limited by environmental
hazards and increased costs2S. Additionally, certain reagents
used for organic digestion have the potential to cause
damage to MPs particleszg. Furthermore, visual classification
using optical, stereoscopic, and anatomical microscopy is
not without its challenge326'30. The determination of MPs
particles heavily relies on the expertise and operation of
the analysts, as well as the instrument settings. These
findings emphasize the difficulty in achieving consistency and
accuracy when employing various methodologies, thereby
complicating the comparison of results across different

studies.

To ensure the reliability and comparability of data across
studies, it is imperative to establish a standardized protocol
for MPs extraction and detection in soil. This standardization
will not only enhance the accuracy of MPs occurrence
assessments but also facilitate a more comprehensive and
unified understanding of the environmental impact of MPs in
soil ecosystems. To address the limitations of extraction and
detection methods, the selected reagents for standardized
methods should be readily available, should not affect the
integrity or chemical composition of the MPs particles,
and pose the lowest feasible environmental risk. Moreover,
standardized methods should demonstrate high efficiency in
both recovering MPs and removing organic matter from the

soil matrix.

An easy-to-follow protocol is vital for widespread adoption
across different research settings. Considering both MPs

recovery rates and cost-effectiveness, saturated NaCl is the
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optimal choice for large-scale soil sample density separation.
For the digestion of organic matter, NaOH was used, as
preliminary isolation experiments have shown that4 M NaOH
solution effectively decomposes soil sample impurities, such
as plant residues, without causing significant damage to the
MPs. In general, this experimental method utilizes readily
available and cost-effective materials, has low operational

complexity, and ensures a reliable extraction rate.

We recommend using the rapid and economical separation
methodology proposed by Chinese Academy of Agricultural
Sciences to determine MPs collected in agricultural fields3?.
For all following steps, ensure that all containers, instruments,
and glassware are cleaned with DI water before use
to minimize contamination. Also, ensure to run regular
blanks alongside the samples to account for contamination

introduced by the collection and extraction procedures.

Protocol

NOTE: The following solutions need to be prepared at
ambient temperature prior to the extraction process: 1)
Saturated NaCl solution (5.7 M) - dissolve 1 kg of NaCl in 3 L
DI Ho0O; 2) 4 M NaOH - dissolve 480 g NaOH in 3 L DI Hy0;
3) Nile Red (100 ug mL"’ ) - dissolve 10 mg of Nile Red in 100

mL of appropriate solvent (e.g., methanol, acetone).

1. Soil sampling and preparation

1. Collect a representative soil sample using a five-point
sampling method in a "W" shape manner across the
study area (Figure 1). Use a 30 cm stainless-steel soil
auger for the collection procedure. Collect and store the
samples in a non-plastic container, such as aluminum

foil.

NOTE: The soil samples can be split into different
desired depths (e.g., 0-10, 10-20, and 20-30 cm).
To minimize plastic contamination, avoid using plastic
sampling equipment and storage containers. Instead,
non-plastic containers such as aluminum foil are used to
collect and store the samples. These samples can either
be bulked to provide one composite sample or kept as

independent replicates.

Dry the soil at room temperature away from direct

sunlight.

1. If a soil drier is available, use it to process multiple
soil samples simultaneously, as the filter within the
individual chambers minimizes the risk of cross-

contamination.

2. Otherwise, use an oven set to 40 °C and dry the soll

for a minimum of 24 h, until completely dry.

3. Grind and sieve the dry soil using a 2-5 mm metal
sieve. Remove visible plant material, stones, and
other inert materials.

NOTE: Loosely cover the soil with aluminum foil
to minimize airborne contamination within the oven/
drier. Collect visible plastic debris (> 5 mm) from
the soil with metal tweezers and place them in a
plastic-free storage container, if later analysis of

macroplastic is to be carried out.

Using a 2 decimal-place scale, weigh out 5.0 g + 0.05
g of the soil sample onto a plastic-free weighing paper
or aluminum foil. Use a new weighing paper for different
samples to minimize cross-contamination. Samples can

be stored in plastic-free containers (e.g., glass vials).
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2. Density flotation

Transfer the 5.0 g dried soil sample into a clean 600 mL
glass beaker (Beaker A). Ensure accurate labeling of all

storage containers and beakers.

Add 230 mL of saturated NaCl solution to beaker A. Place
beaker A on a magnetic stirring plate and add a glass
magnetic stirrer. Stir the solution for 30 min at 260 rpm,

until fully homogenized.

Once fully homogenized, remove the magnetic stirrer
from the solution and rinse with saturated NaCl solution
to prevent plastic particles from being carried out of the
solution. Place the beaker on a flat surface without direct
sunlight and leave it standing overnight, until full density
separation has occurred.

NOTE: When performing the entire procedure, it is
necessary to fully cover with aluminum foil to avoid plastic

contaminants from the air.

3. Impurity digestion

Once the contents of beaker A have completely
separated, carefully transfer the supernatant to a new,
clean 600 mL glass beaker (beaker B). Carefully rinse
the inner walls of beaker A with saturated NaCl solution.
Transfer the supernatant to beaker B. Perform this
procedure 2-3 times.

NOTE: A total of 200 mL of supernatant is recommended.
Ensure that the total supernatant volume is consistent
while maintaining the same concentration of digestion

solution in the next step.

Add 4 M NaOH solution to the sample in beaker B
to reach a fixed volume of 500 mL. Place beaker B

on a magnetic stirring plate, add a glass magnetic

stirrer, and stir the solution for 30 min at 260 rpm
until fully homogenized. Keep the beaker covered with
aluminum foil during this process to minimize airborne

contamination.

Once fully homogenized, remove the magnetic stirrer
from the solution and rinse with saturated NaCl solution
to remove any attached particles. Place beaker B on a
flat surface without direct sunlight and leave it standing
overnight until full density separation and organic matter
digestion have occurred.

NOTE: When performing the entire procedure, it is
necessary to fully cover with aluminum foil to avoid
plastic contaminants entering the solution from the air.
The digestion duration depends on the quantity and the
type of organic material. Extend the digestion time if
required to ensure complete organic matter digestion.
After successful digestion, the supernatant should look

clear with no visible organic matter floating in the beaker.

4. Coloration with Nile Red solution

Once the contents of beaker B have completely
separated, carefully transfer the supernatant to a new,
clean 600 mL glass beaker (beaker C). Rinse the inner
walls of beaker B with DI water to ensure maximum

particle transfer.

1. If the volume in beaker C is less than 500 mL, make
up the value to 500 mL with DI water to unify the

solution volume.

Add the Nile Red solution to beaker C to achieve a final
maximum concentration of 0.5 M. Stir the solution with
a glass rod until completely homogenized, then let the
solution incubate for 30 min in the dark by covering the

beaker with aluminum foil.
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5. Vacuum filtration

Set up the vacuum filtration devices in the following
order: glass funnel, metal clamp, vacuum filtration base,
collection beaker, connection hose, moisture trap, and
vacuum pump. Carefully remove a new membrane (0.2
um pore size, 47 mm diameter) from its storage container
using metal tweezers. Place the filter membrane centrally
and flat on the top of the vacuum filtration base.

NOTE: Ensure a secure connection by aligning the
vacuum filtration base with the glass funnel and fastening

it with a metal clamp.

Activate the vacuum filtration and slowly pour the liquid
from beaker C into the glass funnel. Rinse beaker C
several times with DI water to maximize particle recovery.
Rinse the sides of the glass funnel with DI water after
sample filtration to ensure minimal particle loss.

NOTE: Cover the glass funnel with aluminum foil to
minimize airborne contamination during the filtration
process. If the sample has a high particle number
and the filtration speed decreases, multiple membranes
can be used for the same sample. This will ensure
an even distribution of particles across the membrane
and minimize the risk of particles aggregating and

overlapping for later quantification.

Once filtration is completed, carefully retrieve the filter
membrane from the porous plate using tweezers and
place each membrane in an individual glass Petri dish.
Let the membrane fully dry before closing the Petri dish
and wrapping it in aluminum foil. Store itin a dry and dark

place until further analysis.

6. MPs particle quantification by fluorescence
microscopy

2.

If the exact location of fluorescent particles on the
membrane is required for later polymer identification

(e.g., by using FTIR), please refer to the steps below:

1. Use a black gel pen to gently mark the beginning
position and 10 marks on the filter membrane,
following the shape of the "Z" (Figure 2). Place
the membrane carefully on the glass slides on the
microscope stage using tweezers, ensuring a flat

sample surface.

2. Activate the fluorescence instrument in the following
order: the host, fluorescent sources, monitor, and
fluorescence microscope. Turn on the instrument
and set the source's light knob to maximum
brightness. Utilize the bright field (BF) and

fluorescent light (FL) switch buttons to take BF and

FL images, respectively.

3. Using the software for sample observation and

recording (e.g., DP2-BSW), take bright field pictures
under the BF position. Turn the knob into FL position
and take pictures with the fluorescence filter in the
dark. Ensure the field of view observation sequence
runs from 1 to 10. Make sure the FL and BL pictures
are taken in the same position.

NOTE: Fluorescent microscopic analysis should be
carried out within 24-48 h after filtration to ensure
optimal fluorescence of particles. Ensure the BF and
FL images are taken in the same position (Figure 3).
Ensure all membranes are analyzed using the same

magnification and instrument settings.

For polymer identification by using LDIR, perform the

microscope steps as below:
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Set up the microscopy system as follows: the
camera, filters, magnifications and microscope
stage, and computer. Select the appropriate filter
mode best suited for the desired excitation and
emission wavelengths (e.g., 470 nm and 495 nm,

respectively) depending on sample and background

fluorescence.

Wipe the filter membrane holders with dust-free
tissues, then secure the membrane in the holder
and slide onto the microscope stage. Scan the entire
membrane visually to ensure an even distribution of

particles.

Ensure the camera is connected, and the
microscope magnification is appropriate for all
sample types and consistent across all samples from
the same set. Determine the size of the area in
mm captured with the camera before starting the
analysis by using a measuring tape.

NOTE: If particles are evenly distributed, analyze
a minimum of 10% of the total membrane area by
selecting the required number of sampling points
on the membrane. Take a picture of each sampling

point using the camera.

7. MPs polymer identification using FTIR or LDIR
spectroscopy

1. IfFTIR is used to identify polymer particles, please refer

to the steps below.

1.

Turn on the FTIR spectrometer and corresponding
software for sample observation and recording.

Clean the probe before measuring each sample.

Identify the particles for monitoring through real-time

screen recording. Adjust position and sharpness by

manipulating the rocker. Bring the operating platform
to the center and capture the current air background
spectrum.

NOTE: Target particles that correspond to both BF

and FL images.

Measure 3-5 fixed points on each particle to attain

spectra within the infrared wavenumber range of

400-4,000 cm™'. On the results page, save the
original data, obtain the spectrum, and compare it
with the plastic spectrum in the standard library to
confirm the sample's hit quality index (Figure 4).

NOTE: In this study, due to the small size of MPs and
the challenges in quantifying them across the entire
filter, 5-7 representative particles were selected from
each sample for FTIR analysis. To ensure an even
distribution, particles following a "Z-shaped" pattern
across the filter were selected. However, it should
be noted that some uncertainty may arise, as the
particles were selected randomly rather than by

scanning the entire filter.

A match is accepted if the hit quality index (HQI)
> 0.7. Figure 4 shows an example of particles
identified by FTIR spectroscopy in a soil sample

spiked with 0.04% PE-MPs.

2. If LDIR is used for polymer particle identification, follow

the steps below:

1.

Once the fluorescent microscope steps are
completed, resuspend the particles for analysis on
the LDIR. Place the filter membrane into a new glass
vial and add 20 mL of pure ethanol. Close the vials
tightly and wrap the lids with paraffin film to prevent

leakage.
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Sonicate samples in an ultrasonic bath for a
minimum of 1 h until all particles have been
resuspended. Remove and discard the membrane
from the glass vial.

NOTE: Ensure the membrane side with particles
faces inwards, i.e., away from the vial wall.
Sonication time depends on the membrane type
used; the membrane may leach color, but this will

not interfere with the polymer identification.

Confirm the successful particle resuspension by
reanalyzing membranes under the fluorescent

microscope and ensuring particle removal is > 95%.

Place the glass vials with the ethanol solution on
a magnetic stirring plate and add a small magnetic
glass stirrer to the vial. Let the ethanol evaporate to
less than 5 mL by setting the plate temperature to
100 °C and stirring at a low speed to keep particles

suspended.

more times to analyze 3 replicates per sample on

each slide.

7. Use the particle analysis tool in the associated
software to measure the infrared spectra of each
particle within the set size range and match them
against the internal library for polymer identification.
NOTE: One point on each particle is automatically

measured in the infrared wavenumber range of

800-1800 cm™', and particles are automatically
matched against known library spectra of polymers

and other organic and inorganic materials.

8. If the hit quality index (HQI) = 0.8, the match is
accepted. Figure 5 shows an example of particles
identified by LDIR spectroscopy in a soil sample
spiked with 0.04% PE-MPs.

NOTE: Sample volume can be increased for

samples with low particle numbers.

8. Particle quantification of fluorescent membrane

NOTE: Cover the vials lightly with aluminum foil
to minimize airborne contamination of the samples.
Optionally dry the solution under a gentle stream of

nitrogen for ethanol evaporation.

Transfer the sample into a small 8 mL glass vial,
using new ethanol to rinse the 20 mL glass vial to
maximize particle recovery.

NOTE: If required, add new ethanol to the small

glass vial to reach exactly 5 mL. 2.

To prepare the sample for analysis on the LDIR,
shake the sample thoroughly until all particles
are homogenously suspended in the solution and
quickly pipette 10 pL of the sample onto the slide

and let the ethanol evaporate. Repeat this step two

images using ImageJ

Open ImageJ32 (version 1.54f) and load images into the
software. Adjust the scale of the image to the correct
measurements corresponding to the real image size. Use
the functions Analyze > Set scale to input image pixel
and size (mm) values, then select Global to apply these

settings to all images during the session.

Transform the image into a binary image and convert it to
8-bit, using the functions Process > Binary and Image
> Type > 8-bit, respectively. To select the parameters
for particle analysis, use the functions Analyze > Set
measurements and select the desired parameters, e.g.,
Area, Shape descriptors, and Feret's diameter. Select
Add to overlay and determine the number of decimal

places for data output.
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3. To analyze particles, select Analyze > Analyze
particles and determine the particle size range of
interest. Set Circularity to 0-1, unselect Pixel units,
enable Overlay to be shown, and select the following
boxes: Display results, Exclude edges, Clear results,
Include holes, Summarize, and Overlay. Export results
as .csv files from the results window.

NOTE: The analysis of fluorescent images will only
provide information on particle number, not polymer
number; therefore, an additional identification procedure
is required, for example,

using IR spectroscopy

techniques.

Representative Results

To validate the recovery rates of this methodology, samples
from three different solid matrices (silicon dioxide (SD),
bentonite clay (BT), and soil) were analyzed in sets of three
replicates. Samples were analyzed with and without the
addition of 0.04% w/w white polyethylene (PE) microplastic
(particle size range 40-48 pym). Soil samples were collected
from Haidian District, Beijing, China (China Agricultural
University West Campus), and soil was classified as umber
soil. Additionally, three replicates of blanks were included
introduced

to account for any potential contamination

throughout the extraction and analysis process.

The average recovery rates were 84%, 83%, and 90% of
BT, SD and soil, respectively. On average, 86% of the PE
particulates were successfully recovered within a set size
range of 20-500 um. The interference of results from the
blank sample and chemical identification were eliminated.
The particle loss could be accounted for by supernatant
transfer, filtration, or incorrect identification. The variation in
recovery rates can be influenced by factors such as the type

of salt solutions, digestion solutions, and reaction times33:34.

Furthermore, a global meta-analysis reported that recovery
rates in soil MPs extraction experiments typically range
from 71% to 93%3%. Therefore, the experimental results in
this study are valid and meet the standards required for

microplastic analysis in soils.

Additionally, apart from PE, the phenolic resins, polyamide
(PA), polypropylene (PP), and polyvinyl chloride (PVC), were
also identified (Table 1). These contaminations may have
originated from the filtration device, laboratory equipment,
atmospheric deposition, or DI water. Although saturated NaCl
may result in relatively lower recovery rates for high-density
microplastics (MPs), both our results and previous studies
have reported recovery rates of 92%-100% for high-density
MPs, such as polyamide (PA, 1.12-1.69 g/cm3) and polyvinyl
chloride, (PVC, 1.35-1.45 g/cm?3)33.34,

The main result of MPs sampling and sample analysis is the
quantification and identification of MPs particles per sample.

The formula used to determine abundance (items kg'1 ) is:

Se X5
. r
1= w

where N;and n represent the particle abundance and number
of each sample under ImageJ software, respectively. S;
and Sr denote the effective filtration area of a single filter
membrane and each vision field area, respectively. The w
stands for the weight of each sample, which is 5 g in this

example.

N, =recoveryrate x N,

lastic particle
i e x 100%

recoveryrate = -
) all particles detected

where N represents the abundance of plastic particles after

identification, and the recovery rate is calculated as the
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ratio of plastic fragments to the total number of detected 80% or above, respectively. That means the sample spectra
particles. The hit quality index (HQI) indicates the level of  are 70% and 80% or more, similar to the closest match in
similarity between measured sample spectra and the best  the Iibrary36.The recovery rate and polymer identification of
match found in the library. In this study, the FTIR and LDIR  the BT, SD, soil samples, and blanks after extraction and

HQIl standards for polymer matches are set at 70% and  subsequent FTIR analysis are shown in Table 1.

. Sampling point

30 meters

| 30 meters |

Figure 1: A schematic representation of a soil sampling strategy using the 'W' approach. Please click here to view a

larger version of this figure.
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Figure 2: The filter membrane for FTIR detection is marked with a black gel pen in a Z-shaped sequence of 10

positions. Please click here to view a larger version of this figure.

200pm

Figure 3: The membrane image of suspected MPs particles (in green) from soil taken using the fluorescence

microscope. A) Example of particles under bright field (BF) and B) fluorescent light (FL) microscopy. Please click here to

view a larger version of this figure.
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Figure 4: A schematic diagram of the results based on the FTIR method. Comparison of the spectrogram of the sample
and the PE standard, and PE particle spectra (red line) matched against the closest library spectra (blue line) with a match

quality of 0.98. Please click here to view a larger version of this figure.

Polyathylene

Figure 5: A schematic diagram of the results based on the LDIR method. A) Particles identified using LDIR chemical
imaging in 10 yl of a 5 ml ethanol solution, after extraction of soil spiked with 0.04% w/w PE; B) PE particle spectra (red line)
matched against the closest library spectra (blue dotted line) with a match quality of 0.98. Please click here to view a larger

version of this figure.
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Samples Bentonite clay (BT) Silicon dioxide (SD) Sail
1 recovery rate 89.30% 81.50% 95.20%
2 recovery rate 81.70% 87.60% 86.70%
3 recovery rate 82.40% 79.60% 88.30%
Total recovery rate (%) 84.50% 82.90% 90.10%

Polymer type PE (93.3%) PE (86.4%) PE (89.6%)
Phenolic resin (6.7%) Polyvinyl chloride (13.6%) Polyamide (6.8%)
Polypropylene (3.6%)
Discussion protocols are commonly employed for the separation of

The soil sampling strategy in the field, including approaches
such as simple random sampling or systematic grid sampling,
as well as the sampling area and depth, must be tailored to
the specific research questions and clearly defined prior to the
sample collection. Some studies have focused on the topsoil

34'37, whereas other collected soil samples

layer of 0-10 cm
with a depth of 0-40 cm38. Since the size and abundance of
MPs vary in different soil depths, it is necessary to unify the
depth for soil sampling. We suggest considering a depth of
0-30 cm to be appropriate and practical for agricultural fields,
as this is the typical plow depth39'40. Moreover, the research
objective, sampling approaches, and sampling area must
be designed to address the predefined research question.
Additionally, during the collection and transportation of the
samples, every effort should be made to avoid contamination
from plastic products by replacing them with suitable sampling

containers like aluminum boxes, paper bags, or cardboard

containers.

Selecting the most appropriate solutions for density
separation and organic digestion is the critical step in
the protocol, as they affect MPs extraction efficiency and
minimize the potential damage of MPs, thereby affecting

the final MPs extracted from samples. Density separation

MPs from the soil, with high-density salt solutions being the
most frequently used extraction media. The recommended
salt solutions include NaCl (1.2 g cm‘3), Nal (1.8 g cm'3),
Nag[HoW12046] (1.4 g cm™3), ZnCl, (1.6-1.7 g cm™), and
NaBr (1.55 g cm'3). Considering both MPs recovery rates
and cost-effectiveness, saturated NaCl is the optimal choice
for large-scale soil sample density separation, though it
may lead to relatively lower recovery for high-density MPs
(such as PVC). However, sample preprocessing in previous
studies has indicated that NaCl can also extract high-
density polymer334*33. In addition, ZnCl, is a more suitable
extraction solvent for biodegradable plastics. A recently
published H,0O-ZnCl, extraction method specifically for
biodegradable polymers by Li et al., (2023) can maximize the
integrity of biodegradable plastics themselves while ensuring
high recovery efficiency (91.7% % 7.5%)41. Regarding the
extraction time, we have chosen a significant period of settling
to ensure high extraction efficiency for MPs. This extended
duration facilitates thorough contact between the solution
and the soil sample. However, some studies suggest that
settling for 8-12 hours is also acceptable"’z’31 . The minimum
extraction time required is typically between 8 to 12 hours,

although this duration may increase depending on the soil

Copyright © 2025 JoVE Journal of Visualized Experiments

jove.com

March 2025217 - €67064 - Page 13 of 17


https://www.jove.com
https://www.jove.com/

jove

texture. Additionally, if the extracted soil sample is larger than
the 5.0 g used in this protocol, two flotation processes can be

conducted4.

The majority of current research suggests utilizing acidic
and alkaline solutions to digest the organic fraction from
the sample43’44. Preliminary isolation experiments of MPs
from soil have indicated that the remaining impurities after
the density separation can be mainly attributed to dry plant
residues. Therefore, low concentrations of strong acidic
or alkaline solution are recommended to decompose the
impurities without causing noticeable damage to the MPs.
Some studies use 30% H»O» solution*®, however, since
soil typically has a higher organic matter content compared
to air, water, and sediment samples, a stronger solution
(i.e., NaOH) is recommended in this protocol. It is worth
noting that controlling the concentration and reaction time
of the digestion solution is essential, as excessively high
concentrations or prolonged reaction times may damage

MPs, leading to a change in the physical properties of MPs31.

The initial method of MPs analysis involved visual

identification under a light microscope. However, this
technique by itself is highly error-prone due to the potential
to introduce bias*®. Currently, there are various identification
methods for polymers, with FTIR spectroscopy and Raman
spectroscopy being the most commonly used*’. FTIR
spectroscopy can further be categorized into attenuated
total reflectance (ATR)-FTIR spectroscopy and pFTIR
spectroscopy, which are suitable for chemical structure
identification based on particle sizes (particles > 0.5 mm
and particles < 0.5 mm, respectively). These methods are
simple, convenient, and can provide fast and accurate results,
making infrared spectroscopy the most popular technology

for identifying MPs*®. Additionally, a more recent technique

known as laser direct infrared (LDIR) chemical imaging has
gained attention®. This method can reliably detect MPs
particles within a size range of 20-500 ym with a faster
detection speed, but its higher cost has limited widespread

adoption for now.
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